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Abstract
The Hydrologic Toolbox is a Windows-based desktop 

software program that provides a graphical and mapping 
interface for analysis of hydrologic time-series data with a set 
of widely used and standardized computational methods. The 
software combines the analytical and statistical functional-
ity provided in the U.S. Geological Survey Groundwater and 
Surface-Water Toolboxes and provides several enhancements 
to these programs. The main analytical methods are the com-
putation of hydrologic-frequency statistics such as the 7-day 
minimum flow that occurs on average only once every 10 
years (7Q10); the computation of design flows, including bio-
logically based flows; the computation of flow-duration curves 
and duration hydrographs; eight computer-programming meth-
ods for hydrograph separation of a streamflow time series, 
including the Base-Flow Index (BFI), HYSEP, PART, and 
SWAT Bflow methods and Eckhardt’s two-parameter digital-
filtering method; and the RORA recession-curve displace-
ment method and associated RECESS program to estimate 
groundwater-recharge values from streamflow data. Several of 
the statistical methods provided in the Hydrologic Toolbox are 
used primarily for computation of critical low-flow statistics. 
The Hydrologic Toolbox also facilitates retrieval of stream-
flow and groundwater-level time-series data from the U.S. 
Geological Survey National Water Information System and 
outputs text reports that describe their analyses.

The Hydrologic Toolbox was developed by use of the 
DotSpatial geographic information system (GIS) programming 
library, which is part of the MapWindow project. DotSpa-
tial is a nonproprietary, open-source program written for the 
.NET framework that includes a spatial data viewer and GIS 
capabilities. Advantages of the DotSpatial system include its 
pure .NET implementation for both the user interface and the 
GIS mapping engine, and thus the DotSpatial system sim-
plifies software deployment and installation. In addition to 
combining the functionality of the separate Groundwater and 

Surface-Water Toolboxes, the Hydrologic Toolbox also orga-
nizes the functionality by theme (Groundwater Tools, Surface-
Water Tools, and general Time-Series Tools).

This report provides a description of how to build a 
Hydrologic Toolbox project and to download and man-
age hydrologic time-series data. It includes an overview of 
the analytical and statistical capabilities of the Hydrologic 
Toolbox and highlights the primary differences between the 
Hydrologic Toolbox and the Groundwater and Surface-Water 
Toolboxes. The report supplements information available in an 
extensive online Help manual and is intended to provide a set 
of instructions that will allow users to quickly develop skills 
to use the mapping, data-retrieval, and computational tools of 
the program.

Introduction
The Hydrologic Toolbox is a Windows-based desktop-

software program that provides a graphical and mapping inter-
face for the analysis of hydrologic time-series data with a set 
of widely used and standardized computational methods. The 
program combines the analytical and statistical functionalities 
provided in the U.S. Geological Survey (USGS) Groundwater 
(GW) and Surface-Water (SW) Toolboxes (Barlow and others, 
2015; Kiang and others, 2018) in a single Hydrologic Toolbox 
and provides several enhancements to these programs. The 
software also facilitates the downloading and plotting of 
streamflow and groundwater-level time-series data from the 
USGS National Water Information System (NWIS) data-
base (U.S. Geological Survey, 2020a). A set of procedures is 
provided to

• separate the hydrograph of a streamflow time series 
into daily, monthly, and annual base-flow and runoff 
components of streamflow;

• analyze a graph showing a streamflow-hydrograph 
recession to determine the base-flow recession con-
stants and the monthly and annual groundwater-
recharge rates;
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• compute n-day frequency statistics such as the 7Q10—
the 7-day minimum flow that occurs on average only 
once every 10 years;

• analyze the frequency of any annual time series by 
using the log-Pearson type III distribution;

• compute biologically based design flows, flow-duration 
statistics, and a variety of monthly, seasonal, and 
annual statistics;

• test for a monotonic trend in annual time series; and

• graph time-series data, flow-duration curves, and flow-
frequency curves.

The GW and SW Toolboxes were built by using the U.S. 
Environmental Protection Agency’s (EPA’s) BASINS plat-
form (U.S. Environmental Protection Agency, 2020), which 
is a customized interface developed with the MapWindow 
software (MapWindow, 2021). The Hydrologic Toolbox was 
developed with the DotSpatial geographic-information system 
(GIS) programming library, which is part of the MapWindow 
project (MapWindow, 2021) and an advancement over the 
GIS environment of the GW and SW Toolboxes. DotSpa-
tial is a nonproprietary, open-source program written for the 
.NET Framework that provides a spatial data viewer and GIS 
capabilities. Both MapWindow software and the DotSpatial 
system mostly use the same set of open-source GIS librar-
ies and support custom applications written in Visual Basic 
.NET (VB.NET) programming language, such as those 
developed for the GW and SW Toolboxes. Advantages of 
the DotSpatial system include its pure .NET implementa-
tion for both the user interface and the GIS mapping engine, 
which together simplify software deployment. Users of the 
GW and SW Toolboxes will find the procedures for building 
a Hydrologic Toolbox project and downloading and analyz-
ing time-series data to be similar to the procedures for the use 
of the GW and SW Toolboxes themselves. The Hydrologic 
Toolbox replaces the GW and SW Toolboxes and the USGS 
Surface-Water Statistics (SWSTAT) program (U.S. Geological 
Survey, 2020b).

This report (1) provides a description of how to build a 
Hydrologic Toolbox project and download and manage hydro-
logic time-series data, (2) includes an overview of the analyti-
cal and statistical capabilities of the Hydrologic Toolbox, and 
(3) highlights the primary differences between the Hydrologic 
Toolbox and each of the GW and SW Toolboxes. Detailed 
information on the analytical and statistical methods and their 
use in the Hydrologic Toolbox are given in Barlow and oth-
ers (2015) and Kiang and others (2018). The report supple-
ments information available in an extensive Help manual 
(“Hydrologic Toolbox Documentation”) that is part of the 
computer program itself and is intended to provide a set of 
instructions that will allow users to quickly develop the basic 
skills required for the use of the mapping, data-retrieval, and 
computational tools of the program.

The Hydrologic Toolbox program is publicly available 
for downloading (see Barlow and others, 2022). Installation 
instructions are available with the download package. The 
R statistical program also must be installed to utilize the R 
screening tests (see section on “Surface-Water [SW] Tools”). 
All other aspects of the Hydrologic Toolbox will function 
properly without R.

A few text-formatting conventions are used throughout 
the report. Components of the Hydrologic Toolbox interface, 
such as dialog boxes, panels, or buttons, are named with initial 
capital letters and are in double quotation marks, such as the 
panel name “Select Data.” Specific menu options and tools 
are in boldface text, such as the “Open” option in the “File” 
menu, which is available on the main toolbar. Unless other-
wise stated, the Hydrologic Toolbox is referred to simply as 
“the Toolbox” in the rest of the report.

Building, Saving, and Reopening a 
Hydrologic Toolbox Project

A Hydrologic Toolbox project is a collection of spatial 
and time-series data and analysis results for a specific geo-
graphic area. The project area can consist of a State, County, 
or one or more hydrologic unit code (HUC) hydrologic 
cataloging units. A cataloging unit is one of the divisions of 
the hydrologic unit code classification system of river basins 
in the United States developed by the USGS (Seaber and oth-
ers, 1987). Each cataloging unit is given an 8-digit HUC—for 
example, the Pawcatuck-Wood Basin in Rhode Island has a 
HUC–8 code of 01090005.

Opening the Hydrologic Toolbox for the first time results 
in the two dialog boxes shown on figure 1. A new project 
can be created by selecting the “Build New Project” option, 
which produces a map that shows the States and cataloging-
unit boundaries (fig. 2) of the conterminous United States. 
The user can then zoom into an area of interest with the “Pan” 
and “Zoom” tools. Adding cataloging-unit identifiers to the 
map aids in the selection of a basin of interest. This is done 
by right-clicking on the Cataloging Units (CU) layer, which 
results in a list of several menu options; the user selects 
“Labeling” and then “Label Setup” from the next list of 
options. The result of these selections is the “Feature Labeler” 
dialog box shown on figure 3. The user can then scroll down 
to the “CU” option in the “Field Names” list. Double-clicking 
on the “CU” field and then clicking “OK” adds the labels to 
the map (fig. 4A).

The “Select” tool can then be used to select the catalog-
ing unit of interest (01090005, fig. 4B). The user selects the 
“Build” check box from the “Build New USGS Hydrologic 
Toolbox (1.0.0) Project” dialog box (fig. 2). At this point, 
the Toolbox will prompt the user with a “Save new project 
as…” dialog box to select a directory in which to save the 
project. Project information is stored in a DotSpatial system 
project file (ending in .dspx) in the chosen project directory. 
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Figure 1. Screen capture of the “Welcome to the USGS Hydrologic Toolbox (1.0.0)” and “USGS Hydrologic Toolbox” dialog boxes that 
appear during the first use of the U.S. Geological Survey Hydrologic Toolbox.

If multiple projects have been created for the same HUC–8 
area, a sequence number will be appended by a hyphen to the 
subdirectory and project names (for example, 01090005-2). 
A “Projection Properties” dialog box will appear, and the user 
can select the desired map projection for the GIS data layers 
in the project: the default “Albers Equal-Area (Conterminous 
U.S.)” option was selected for this example. The project then 
will be populated with a set of standard data layers, includ-
ing the locations of NWIS streamgages and monitoring wells 
with daily data (fig. 4C). (Symbols for each data layer can be 
shown on the map by toggling the “+/-” options for each map 
layer in the “Legend.”) The project can now be saved by using 
the “Save” or “Save as…” options under the “File” menu. To 
close the project, use the “Close” option under the “Project” 
menu. Note that opening a new project with the “New” option 
under the “File” menu will close an opened project.

There are additional approaches for building a new proj-
ect while working in the Toolbox. First, the user can access the 
“Welcome to USGS Hydrologic Toolbox (1.0.0)” dialog box 

by using the “Welcome Screen” option from the “Help” menu. 
Alternatively, the user can access the “New HUC8 project…” 
option from the “Project” menu. In both cases, the “Pan,” 
“Zoom Out,” and “Zoom In” tools can be used to navigate 
to the basin(s) of interest within the map that is shown in the 
dialog box.

An existing project can be reopened from the “Welcome 
to USGS Hydrologic Toolbox (1.0.0)” dialog box or with the 
“Open…” option from the “File” menu. MapWindow projects 
created with either the GW or SW Toolbox also can be opened 
and modified with the Hydrologic Toolbox, but must then be 
saved as a DotSpatial system project.

Data layers for the Hydrologic Toolbox are stored on a 
web server maintained by the EPA. If that server is temporar-
ily unavailable, a dialog box will be shown indicating that 
“One (or more) of the core data sets is temporarily unavailable 
for download.”
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Figure 2. Screen capture from the U.S. Geological Survey Hydrologic Toolbox of the initial map with active State and hydrologic unit 
code and eight-digit (HUC–8) hydrologic cataloging-unit data layers. From left to right, the “Pan,” “Zoom In,” “Zoom Out,” “Select,” and 
“Deselect” icons within the red boxes are identified.
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Figure 3. Screen capture from the U.S. Geological Survey Hydrologic Toolbox of the “Feature Labeler” dialog box used to add labels to 
a map layer.
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Figure 4. Screen captures from the U.S. Geological Survey Hydrologic Toolbox showing steps selected to build a Hydrologic Toolbox 
project. A, Cataloging-unit numbers are added to identify hydrologic unit code and eight-digit (HUC–8) basins in the area of interest.  
B, The basin of interest is selected (Pawcatuck-Wood, 01090005). C, The resulting map includes locations of measured daily streamflow 
(discharge) and groundwater levels near and within the basin.
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Figure 4.—Continued

Downloading, Opening, and Managing 
Data

The Hydrologic Toolbox provides several options 
for downloading, opening, and managing data. When a 
Hydrologic Toolbox project is created, a large cache of map 
layers is downloaded and stored in the project directory. A 
subset of these layers, which is shown in the “Legend” panel 
(fig. 4C), is made available as part of the initial build of the 
project. Collection sites for several types of monitored data 
are shown by default on the project map. These are sites for 
which a minimum of 10 data values of daily streamflow (dis-
charge), daily groundwater levels, and periodic groundwater 
levels are available through the NWIS database. The sites at 
which periodic groundwater-level data have been collected are 
not displayed on the map by default because they tend to be 
numerous. Their locations can be seen by toggling the check 
box next to the layer identifier to the “on” (checkmarked) 
position.

The first step in data retrieval is to select specific data 
sites on the project map for which data will be downloaded 
from NWIS. For this example, streamflow-discharge data will 
be retrieved for all streamgage locations shown on the project 

map. This is done by clicking on the “NWIS Daily Discharge 
Stations” data layer (fig. 5, step 1), selecting the “Select” 
tool (step 2), and then drawing a box that encloses all of the 
discharge stations on the map (the box is not shown on the 
figure). The selected streamgages will show a light-blue circle 
in the middle of the dark-blue square symbol. Data for a single 
station can be retrieved by using steps 1 and 2 and then select-
ing individual stations on the map. (To select multiple sta-
tions, hold down the “shift” key while selecting the stations.) 
Stations can be deselected with the “Deselect” tool (located to 
the right of the “Select” tool) or by clicking any empty area of 
the map.

After one or more sites are selected, the “Download…” 
option from the “Data” menu is used to retrieve data from 
NWIS. Selecting this option results in the “Download Data” 
dialog box shown in figure 6A. As shown on the figure, several 
types of data can be downloaded; each data type is explained 
in the online “Hydrologic Toolbox documentation.” For this 
example, the “Daily Discharge” button already has been 
selected because of the steps described in the previous para-
graph. Daily-discharge data are reported in units of cubic feet 
per second (USGS NWIS parameter code 00060). The user 
simply clicks the “Download” button to download the data; 
the status of the download’s progress is displayed as the data 
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Figure 5. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing steps used to select sites for which data will be 
retrieved from the U.S. Geological Survey National Water Information System. Steps are described in the text.

are retrieved. A message will appear if the download has been 
successful (fig. 6B). After clicking “OK,” a list of the data files 
that have been created and automatically saved in the project 
directory will be shown (fig. 6C). These data are saved in the 
USGS NWIS RDB’s (relational database) time-series format. 
The user can close the “Data Sources” dialog box by clicking 
on the “X” in the upper-right corner of the dialog box. The 
data are now part of the project and available for use in the 
Toolbox.

Similar steps can be taken to retrieve daily groundwater-
level data from NWIS. These data are stored in NWIS in sev-
eral formats: two examples are the depth to water level in feet 
below land surface (parameter code 72019) and the elevation 
of the water level in feet above the National Geodetic Vertical 
Datum of 1929 (parameter code 72020). The Hydrologic 
Toolbox converts all data formats to depth to water level in 
feet below land surface.

The user can adjust the minimum number of measure-
ment values required at an observation site for the site to be 
shown on the project map by changing the value specified in 
“Min Count” on the “Download Data” dialog box. The default 
value for “Min Count” is 10 measurement values, but this 
value can be modified. After the value of “Min Count” has 

been adjusted for a selected data type, the user clicks on the 
“Download” button, which causes the map to be updated with 
sites that meet the minimum specified count.

When an existing project is reopened, the Toolbox will 
read time-series data that have been previously saved in the 
project directory. These saved datasets might not include 
the most recent data values from NWIS that were added to 
the site(s) after the previous project was saved. The user can 
redownload to get the latest data from the online data sources 
by checking the “Get Newest” checkbox in the “Download 
Data” dialog box (fig. 6A). Note that each time the user 
downloads data, a copy of the data will be placed under the 
“cache” subdirectory in the “Hydrologic Toolbox” direc-
tory. By default, the download process will look for available 
data files in the cached folder first to save processing time. 
Understandably, these cached data can become outdated as 
new data are added to NWIS. Hence, when the user needs 
to download the latest data from online sources, the “Get 
Newest” checkbox should be checked before starting the data-
download process. The Toolbox will then disregard cached 
data files and download the latest full period of record for the 
sites selected. After the data are downloaded, the new data will 
be saved in the project and “cache” directories.
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Figure 6. Screen captures from the U.S. Geological Survey Hydrologic Toolbox showing dialog boxes related to downloading data for 
the Hydrologic Toolbox. A, Dialog box used to select data type. In this example, daily-discharge (streamflow) data will be downloaded 
from the U.S. Geological Survey National Water Information System. B, Dialog box generated by the successful download of discharge 
data from 25 streamgaging sites. C, List of data files that have been saved in the project directory. RDB, relational database. 
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Figure 6.—Continued

Data can also be added to a project by reading them 
directly from a USGS RDB file or by using the scripting capa-
bilities available with the Toolbox (such as reading data stored 
in an Excel file). These options are available by selecting the 
“Open…” item from the “Data” menu. Specific steps for using 
these two options are described in the “RDB File Structure” 
and “Scripting to Import Excel Data” tutorials provided with 
the Toolbox download package.

The “Manage…” option under the “Data” menu provides 
several processes with which to manage the data files that are 
part of the project. These processes are accessed by selecting 
one or more of the RDB files listed on the “Data Sources” 
dialog box and then selecting one of the options under the 
“File” or “Analysis” menus. For example, a data file can be 
removed from the project by selecting “Close selected” under 
the “File” menu.

Time-Series Tools
The Hydrologic Toolbox provides several generic utilities 

through the “Time-Series Tools” menu option for the analysis 
of project time-series data (fig. 7). Each utility is described 
in detail in the online documentation and is briefly summa-
rized here.

Attributes—Computes a variety of annual, seasonal, and 
monthly statistics, such as the mean, minimum, and 
maximum values, for a selected time series (fig. 8A).

Data Tree—Provides a list of many of the attributes and 
computed statistics for a selected time series (fig. 8B).

Events—Provides a synoptic analysis of an observed 
event during the selected time series (fig. 8C).

Graph—Graphs of time-series data, flow-duration curves, 
flow frequencies, running sums, as well as residuals, 
cumulative differences, scatter plots of one or more 
time-series record, double-mass curve, and box whis-
ker (fig. 8D).

List—Generates a list of dates and associated values for a 
selected time series (fig. 8E).

Subset and Filter Time Series—Allows the user to trans-
form the selected data into a variety of formats such as 
creating a subset dataset by date or season or filtering 
the dataset by specific ranges of values (fig. 8F).

Trend—Computes an n-day high or low annual time 
series and uses the Mann-Kendall test to identify 
monotonic trends in the annual time series aggregated 
from a daily time series (fig. 8G).

Generate Time Series—Allows the user to generate new 
time series from one or more of the project time series 
by using a variety of mathematical functions and sub-
setting options.

Selection of any of the “Time-Series Tools” brings up 
the “Select Data” form, which allows the selection of one 
or more time-series datasets available for the project. For 
example, if the “Graph” tool has been selected, the “Select 
Data to Graph” form is opened (fig. 9). The top panel of the 
“Select Data to Graph” form is titled “Select Attribute Values 
to Filter Available Data” and contains dropdown lists with 
time-series attributes. The number and content of these lists 
can be managed through the “Attributes” menu. The default 
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Figure 7. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing the list of “Time-Series Tools” available with 
the Hydrologic Toolbox.

attributes shown with the Hydrologic Toolbox are “Scenario,” 
“Location,” and “Constituent,” but these can be changed by 
the user. When the user selects an attribute from any of the 
lists, the “Matching Data” panel is populated with the datasets 
having the attribute(s) selected. In the example above, all 25 of 
the streamflow records (“Constituent” equal to “Streamflow”) 
were selected by default from the “Location” attribute list. The 
user then selects datasets from the “Matching Data” panel to 
populate the “Selected Data” panel of the form. The user can 
now click “Ok” to graph the selected datasets. The section of 

the form entitled “Date Range of Selected Data” lists both the 
full date range of all the datasets selected as well as the com-
mon date range for the datasets.

Two optional check boxes are available in the lower right 
corner of the “Select Data” dialog box. The first check box 
allows the user to include provisional data in the selected time 
series. By default, provisional data are not included in the 
Hydrologic Toolbox analyses. Selection of the “Subset and 
Filter Time Series” check box will allow the user to subset and 
filter the time series before operation of the specific utility that 
has been selected.



12  U.S. Geological Survey Hydrologic Toolbox—A Graphical and Mapping Interface for Analysis of Hydrologic Data

Figure 8. Screen captures from the U.S. Geological Survey Hydrologic Toolbox showing dialog boxes for several of the “Time-Series 
Tools”: A, “Attributes”; B, “Data Tree”; C, “Events”; D, “Graph”; E, “List”; F, “Subset and Filter Time Series”; G, “Trend.”
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Figure 8.—Continued
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Figure 8.—Continued
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Figure 8.—Continued
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Figure 9. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing “Select Data to Graph” dialog box.

Groundwater (GW) Tools
The Hydrologic Toolbox provides the following three 

options for analysis of groundwater systems that use time-
series streamflow records: (1) a hydrograph (or base-flow) 
separation to compute the base-flow and runoff compo-
nents of streamflow, (2) a recession-curve displacement 
method by RORA to estimate groundwater recharge, and 

(3) a hydrograph-recession analysis to determine base-flow-
recession constants and master (that is, universal) recession 
curves. These methods are identified under the “GW Tools” 
menu as the “Base-Flow Separation,” “Recharge Estimation 
with RORA,” and “Estimate Hydrograph Parameters” options 
(fig. 10). The methods “Base-Flow Separation” and “Estimate 
Hydrograph Parameters” are briefly described here. No modi-
fications were made to the RORA (Rutledge, 1998) program 
in the Hydrologic Toolbox; its use is described in the original 



Groundwater (GW) Tools  17

Groundwater Toolbox (GWToolbox) documentation (Barlow 
and others, 2015) and in the Help manual that is part of the 
program.

Base-Flow Separation

Eight hydrograph-separation methods are provided in 
version 1.0.0 of the Hydrologic Toolbox. Each of the computer 
programs in which the methods were originally implemented 
was reprogrammed from its original Fortran language into the 
VB.NET language. As named in the Toolbox, the methods are 
the following:

HYSEP—The HYSEP Fixed Interval, Local Minimum, 
and Sliding Interval methods originally developed by 
Pettyjohn and Henning (1979) and implemented in the 
HYSEP software by Sloto and Crouse (1996).

PART—The PART method developed and implemented 
in a computer program by Rutledge (1998).

BFI—The Base-Flow Index (BFI) method Standard and 
Modified methods originally developed by the Institute 
of Hydrology (1980a, b) and implemented in a com-
puter program by Wahl and Wahl (1995).

DF-One Param—The single-parameter digital filter origi-
nally described by Nathan and McMahon (1990) and 
implemented in the SWAT Bflow computer program by 
Arnold and others (1995) and Arnold and Allen (1999).

DF-Two Param—The two-parameter digital filter devel-
oped by Eckhardt (2005) and later implemented in a 
computer program described by Eckhardt (2008).

Each method is described in detail in the specific refer-
ences cited above. Additional information about the HYSEP, 
PART, and BFI methods is given in Barlow and others (2015) 
and about the digital-filter methods in the “Digital Filters” 
tutorial available with the software download package. Barlow 
and others (2015) also summarize the simplifying assumptions 
of the hydrograph-separation methods and provide guidance 
for the appropriate use of these methods.

The Toolbox provides three modes of analysis for hydro-
graph separation: Interactive, Batch Map, and Batch File:

Interactive—To analyze a single continuous or intermit-
tent streamflow record.

Batch Map—To analyze multiple continuous or intermit-
tent streamflow records simultaneously and to create a 
batch-run configuration file.

Figure 10. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing the list of the “GW Tools” available in the 
Hydrologic Toolbox.
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Figure 11. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing dialog box in the interactive mode of the 
“Base-Flow Separation” program for analysis of the streamflow record for Meadow Brook near Carolina, Rhode Island.
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Batch File—To automatically run an existing batch-run 
configuration file.

Figure 11 shows the “Base-Flow Separation” dialog 
box used for an interactive analysis of a single streamflow 
record. The “Display Graph” options can be used to generate 
time-series graphs and flow-duration curves of the calculated 
base-flow and runoff time series. Two tutorials are provided 
with the Toolbox download package to assist the user: (1) the 
“Hydrograph Separation” tutorial provides a detailed guide for 
use of the three analysis modes, and (2) the “Analysis of Base 
Flow” tutorial provides examples of trend and subset analy-
ses for a base-flow time series computed by the Hydrologic 
Toolbox.

Estimate Hydrograph Parameters

The Hydrologic Toolbox provides two methods to esti-
mate base-flow recession constants—the RECESS method 
developed by Rutledge (1998) and a correlation method 
initially described by Langbein (1938) and implemented for 
use with the two-parameter digital filter by Eckhardt (2005, 
2008). The RECESS method, which also can be used to com-
pute a master base-flow recession curve from a streamflow 
time-series record, was included with the initial release of the 
GWToolbox and subsequently updated for version 1.3 of that 
program. The tutorial named “RECESS” describes how this 
method is updated in the Hydrologic Toolbox.

For the two-parameter digital filter, a recession constant 
and a maximum calculable long-term ratio of base flow to total 
streamflow (BFImax; Eckhardt, 2005) must be specified. The 
“Two-Parameter Digital Filter” function provides procedures 
to estimate these two parameters. The correlation method is 
used to compute the recession constant, and the backwards-
filtering approach developed by Collischonn and Fan (2013) is 
used to compute BFImax. The function of the two digital filters 
is described in the “Digital Filters” tutorial and in the Help 
manual provided with the program.

Surface-Water (SW) Tools
The Hydrologic Toolbox functions in the same way as 

the original Surface-Water Toolbox (SWToolbox) for comput-
ing duration and frequency analyses of streamflow time series 
(Kiang and others, 2018). The duration analyses include the 
computation of flow durations at a single site, a statistical 
comparison of duration values for two time series, and the 
creation of hydrographs of daily-mean flow durations. The 
integrated frequency analyses include the calculations of both 
biologically and hydrologically based design flows, such as 
the 1B3 and the 7Q10. To support interpretation of the fre-
quency analyses, the Toolbox also provides tests to determine 
statistical trends, outliers, and the fit of the data distribution. 
Methods used in the calculations of the surface-water statis-
tics are described in the original SWToolbox documentation 

(Kiang and others, 2018). Instructions to perform the analyses 
are available in the documentation manual and tutorials found 
within the Hydrologic Toolbox “Help” menu.

The EPA legacy program DFLOW 4.0 (U.S. 
Environmental Protection Agency, 2020), which was included 
in SWToolbox, is not included in the new Toolbox. The legacy 
DFLOW program within SWToolbox was intended to allow 
comparisons between the deprecated EPA program and the 
newly implemented “Design Flow” functionality of SWTool-
box; however, this comparison is no longer needed for the 
statistical analyses provided in the Hydrologic Toolbox. The 
menu configuration remains largely the same, but there are 
a few noteworthy enhancements and corrections to surface-
water analyses included in the new Hydrologic Toolbox 
software.

Menu Configuration

The duration and flow-frequency analyses are now con-
solidated under the “SW Tools” menu within the Hydrologic 
Toolbox, as shown on fig. 12, providing ease of access. Flow-
duration analyses are in the same “Duration/Compare” and 
“Duration Hydrograph” menu options. Frequency analyses are 
still provided under the “USGS Integrated Design Flow (IDF)” 
menu. Options to create and run batch-frequency analyses are 
also still accessed under the “Create SWSTAT Batch,” “Create 
DFLOW Batch,” and “Run Existing Batch” menu options.

By selecting the “Interactive” submenu of the “USGS 
Integrated Design Flow (IDF)” menu, the user is presented 
with the same collection of tabs for the “Select Dates”; 
“N-day, Trend, Frequency”; “Design Flow”; and “Group 
Outlier Test” functions as shown on figure 13. Each of the 
tabbed dialog boxes has the same configurations as in the 
previous program. As was the case for the SWToolbox, the R 
statistical program (R) must be installed to activate the “Group 
Outlier Test” tab and the “Screening Tests (R)” function, both 
of which are available in the “N-day, Trend, Frequency” tab.

Enhancements and Code Corrections

Output from the frequency analysis from the SWSTAT 
batch has been enhanced since the initial release of the 
SWToolbox. Previously, the descriptive statistics and vari-
ables associated with the n-day frequency analysis, such as 
the K-value, standard deviation, and the beginning and ending 
dates, were available in the interactive mode only by export-
ing the “Frequency Grid” results or written within the text 
output of the “Frequency Report.” This information is useful 
in assessing the results of the analyses and also in develop-
ing regional regression equations of the computed frequency 
statistics. The information associated with the analysis is 
now appended in tab-delimited format at the bottom of the 
“Frequency Grid” output file that is generated during the 
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Figure 12. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing the “SW Tools” available within the 
Hydrologic Toolbox.

SWSTAT batch run (fig. 14) within the Hydrologic Toolbox. 
This enhancement was first made available in SWToolbox ver-
sion 1.0.5 (Kiang and others, 2021).

The outputs of two scenarios from the initial SWTool-
box were found to be inconsistent and were updated in the 
Hydrologic Toolbox. First, during low-flow frequency analy-
ses, the application of the conditional-probability adjustment 
(CPA) for records with zero-flow values was found to have 
been applied only to the “Frequency Report” output. Also, 
the option for choosing “Custom” years on the “Select Dates” 
tab was also being applied only to the “Frequency Report” 
output. Within the Hydrologic Toolbox, the CPA for zero flows 
and the “Custom” years are now applied for all output types 

in both the “N-day, Trend, Frequency” and “Design Flow” 
frequency analyses. These corrections were first made in 
SWToolbox version 1.0.5 (Kiang and others, 2021).

An adjustment is also applied to the calculation of the 
harmonic mean when zeroes are present in the flow record. 
The calculation of the harmonic mean is part of the “Design 
Flow” analyses. In the initial version of SWToolbox, the 
program was treating gaps in the record as zeroes and thereby 
incorrectly overadjusting the harmonic mean for zeroes that 
were not actually present in the record. The gaps are now 
excluded, and the adjusted harmonic mean is computed cor-
rectly within the Hydrologic Toolbox.
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Figure 13. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing the 
“Integrated Design Flow” dialog box and tabs. The four items enclosed in red rectangles are 
discussed in the text.
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Figure 14. Screen capture from the U.S. Geological Survey Hydrologic Toolbox showing SWSTAT batch-output file with descriptive 
statistics and variables appended to the file.

Summary
The Hydrologic Toolbox is a Windows-based desktop 

software program that provides a graphical and mapping inter-
face for the analysis of hydrologic time-series data with a set 
of widely used and standardized computational methods. The 
software is the most comprehensive and up-to-date in a series 
of programs for the computation of low-flow statistics, hydro-
graph separation, and recession analyses. It combines the ana-
lytical and statistical functions provided in the U.S. Geological 
Survey Groundwater and Surface-Water Toolboxes into a 
single computing environment, provides several enhancements 
to the original toolboxes, and supersedes these two programs 
and several additional legacy programs that have a more 
limited functionality. The Hydrologic Toolbox also facilitates 
retrieval of streamflow and groundwater-level time-series data 
from the U.S. Geological Survey National Water Information 
System and outputs text reports for a record of the analysis.

This report describes how to build a project in the 
Hydrologic Toolbox and to download and manage hydrologic 
time-series data, includes an overview of the analysis and sta-
tistical capabilities of the Hydrologic Toolbox, and highlights 
the primary differences between the Hydrologic Toolbox and 
the Groundwater and Surface-Water Toolboxes. The report is 
intended to be used in conjunction with an online user manual 
for the software and previously published technical reports 
that document the analytical methods.
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